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Preface

The purpose of this guide is to help you install Operations Analytics Predictive
Insights.

After completing all steps documented in this guide, you will have a set of
running Operations Analytics Predictive Insights components ready to configure
into a fully functional system.

Audience
The audience for this manual is the network administrator or operations specialist
responsible for installing Operations Analytics Predictive Insights.

To install Operations Analytics Predictive Insights successfully, a basic knowledge
of the following is required:
v Administration of the Linux operating system.
v Administration of IBM InfoSphere Streams.
v Administration of the DB2 database management system.
v Administration of OMNIbus and OMNIbus WebGUI.
v Operations Analytics Predictive Insights

Components
IBM® Operations Analytics Predictive Insights consists of four main components.

The IBM Operations Analytics Predictive Insights components are:
v The Database component: is used to store configuration data, metadata and

metric data.
v The Analytic component: performs data mediation and processes incoming data

to discover any anomalies that are present.
v The UI component: presents any discovered anomalies through the IBM

Dashboard Application Services Hub application or the IBM Tivoli Integrated
Portal application.

v The Mediation Tool: is used to configure a data source and the data model that
Operations Analytics Predictive Insights will monitor.

Operations Analytics Predictive Insights documentation includes the following
guides:
v Release notes
v Installation Guide
v Upgrade Guide
v Administration Guide
v Error Messages Guide

© Copyright IBM Corp. 2011, 2016 v
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Chapter 1. Introduction

Operations Analytics Predictive Insights is real-time performance analysis software
for business services.

Operations Analytics Predictive Insights eliminates manual threshold and baseline
configuration by providing a self-learning capability.

By analyzing data from various sources and integrating with existing monitoring
products, Operations Analytics Predictive Insights learns the normal behavior of a
business service and creates a performance model. When Operations Analytics
Predictive Insights detects or forecasts anomalous behavior, an alarm is generated.
Operations Analytics Predictive Insights offers out-of-the-box integration with
Netcool® OMNIbus.

The Operations Analytics Predictive Insights system has four main components:
v The Database component: is used to store configuration data, metadata and

metric data.
v The Analytic component: performs data mediation and processes incoming data

to discover any anomalies that are present.
v The UI component: presents any discovered anomalies through the IBM

Dashboard Application Services Hub application or the IBM Tivoli Integrated
Portal application.

v The Mediation Tool: is used to configure a data source and the data model that
Operations Analytics Predictive Insights will monitor.

© Copyright IBM Corp. 2011, 2016 1
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Chapter 2. Preparing to install

Before you begin installing Operations Analytics Predictive Insights, you must
complete a series of tasks to prepare your system.

Checking the installation prerequisites
Run the prereq_scanner.sh script to check various installation prerequisites for
Operations Analytics Predictive Insights.

Before you begin

If you want to run the prerequisite scanner as a non-root user, enter the following
command to add the /usr/sbin directory to the path variable so the Linux mount,
swapinfo, and psrinfo commands are available to the script:
export PATH=$PATH:/usr/sbin

About this task

The prereq_scanner.sh script completes the following system validation checks:
v System: Checks that all system resources such as CPU, memory, free disk space,

and operating system flavor and version meet the requirements to run
Operations Analytics Predictive Insights. The script checks that your system
meets the minimum requirements to run Operations Analytics Predictive
Insights. For information on the additional system requirements to size
Operations Analytics Predictive Insights for a specific number of KPIs, see
Hardware sizing in the Performance and Sizing wiki

v Libraries and packages: Ensures that the required packages for Operations
Analytics Predictive Insights and its prerequisites are installed in the correct
location.

v Software: Checks that the correct version of DB2 is installed.

Procedure
1. Change to the directory that contains the prereq_scanner.sh script in one of

the following locations:
v The predictiveInsightsInstaller1.3.5 directory within the directory where

you downloaded and extracted Operations Analytics Predictive Insights
v $PI_HOME after you install Operations Analytics Predictive Insights

2. To run the prerequisite scanner, type:
./prereq_scanner.sh

3. Enter the corresponding number to check the prerequisites for the specific
component or components that you wish to install on the server.

Number Checks prerequisites for:

1 The database component only

2 The analytics component only

3 The UI component running in a Dashboard
Application Services Hub environment.
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Number Checks prerequisites for:

4 The UI component running in a Tivoli
Integrated Portal environment.

5 The database, analytics, and UI components
in a Dashboard Application Services Hub
environment.

6 That database, analytics, and UI components
in a Tivoli Integrated Portal environment.

Results

The prerequisite scanner logs the scan activity to a precheck.log file and writes the
results of the scan to the result.txt file. Possible results are as follows:

Table 1. Prerequisite scanner results

Result Explanation

Pass If the target server meets all the
prerequisites, the script returns a pass
for the prerequisite check.

Warning If the target server does not meet one or
more of the prerequisites with a warning
severity level, the script returns an
overall warning results for the
prerequisite check. With a warning
result, you can complete the installation
of Operations Analytics Predictive
Insights, but the performance or
operation of the system may be affected.
Therefore, it is recommended that you
take action to resolve the items with a
warning status before you start the
installation.

Fail If the target server does not meet the
prerequisites, the script returns fail for
the prerequisite check. To resolve the
failure, take the appropriate actions, for
example, install the missing operating
system packages, increase disk space,
modify the configuration settings and so
on.

Creating users to install Operations Analytics Predictive Insights
Create users to install Operations Analytics Predictive Insights and its
prerequisites.

About this task

If you install Operations Analytics Predictive Insights on a single server, you can
use a single or multiple user accounts to install the system requirements and the
Operations Analytics Predictive Insights components. The following instructions
use 2 accounts:
v db2inst1 to install and administer DB2.
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v scadmin to install the other system requirements and Operations Analytics
Predictive Insights.

Create the db2inst1 user on the server on which you plan to install DB2. Create
the scadmin user on all servers on which you plan to install Operations Analytics
Predictive Insights components.

Procedure
1. To create the scadmin user account, log in as root and enter the following

commands:
groupadd scadmin
useradd -g scadmin -d /home/scadmin -s /bin/bash scadmin
passwd scadmin

2. As user root on the database server, create an OS user within the relevant
group.
groupadd db2iadm1
useradd -g db2iadm1 -d /home/db2inst1 -s /bin/bash db2inst1
passwd db2inst1

3. As root user on the database server, add the existing scadmin user to the same
primary group as the DB2® instance owner, by default this user is db2inst1.
For example, add the user scadmin to the group db2iadm1.
usermod -G scadmin,db2iadm1 scadmin

4. On the database server, add the following source command into the
~scadmin/.bashrc file:
if [ -f /home/db2inst1/sqllib/db2profile ]; then
. /home/db2inst1/sqllib/db2profile
fi

The commands assume that:
v db2inst1 is the DB2 instance owner.
v /home/db2inst1 is the home area of the DB2 instance owner
v DB2 is installed in the /home/db2inst1/sqllib directory

Configuring fully qualified domain names for servers
Before you start the installation, ensure that each server that is to host an
Operations Analytics Predictive Insights component has a fully qualified domain
name.

Also, ensure that the host entry in each server's /etc/hosts file is in the following
format:
<ip-address> <fully qualified domain name> <short host name>

Note: Do not install Operations Analytics Predictive Insights on a server that has
an underscore (_) character in its host or domain name. The host name and
domain name must conform to the name requirements described in Internet
Official Protocol Standards RFC 952:
A "name" (Net, Host, Gateway, or Domain name) is a text string up to 24 characters drawn from the alphabet (A-Z), digits (0-9), minus
sign (-), and period (.). Note that periods are only allowed when they serve to delimit components of "domain style names".
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Setting ulimits
Setting the ulimits for your Operations Analytics Predictive Insights system.

Procedure
1. As root, create a file named /etc/security/limits.d/90-nproc.conf and add

the following lines:
* soft nproc 100000
* hard nproc 100000

2. As root, create a file named /etc/security/limits.d/91-nofile.conf and add
the following lines:
* soft nofile 100000
* hard nofile 100000

3. Add the following lines to the .bashrc file of the owner of the Analytics
component (typically scadmin), so that each new shell that user opens has
these updated settings.
ulimit -u 100000
ulimit -n 100000

Installing KSH and required libraries for Operations Analytics
Predictive Insights

Operations Analytics Predictive Insights requires the installation of KSH and some
libraries.

Before you begin

Note: This is not a statement of the libraries required by the Operations Analytics
Predictive Insights pre-requirements, that is, DB2, InfoSphere Streams, and
Netcool/OMNIbus. To find the required libraries for these products, you must run
the product-specific dependency checker scripting or check the product-specific
documentation.

About this task

The Analytics server requires the following packages:
v 64-bit packages:

– atlas
– compat-libgfortran-41
– lapack
– blas
– glibc-devel

The Database server requires the following packages:
v 64-bit packages:

– dapl
– sg3_utils

The following packages are required on all servers in the topology:
v Packages:

– compat-libstdc++-33
– libstdc++
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– compat-libstdc++-33.i686
– libstdc++.i686

KSH is also a software requirement.

Procedure
1. For each required library enter the command, yum install, followed by the

name of that library.
2. If you see this error from yum when installing the 32-bit libstdc++ libraries:

Error: Protected multilib versions: libstdc++

Then run yum update libstdc++ and re-try the install.
3. If KSH is not on your system, install it as follows:

yum install ksh

Installing the prerequisite software
The version numbers of the prerequisite software and the order of installation.

Note: To ensure that you install the correct versions of the prerequisite software,
download and install the following products. For more information, see
Downloading Operations Analytics Predictive Insights

Table 2. eAssembly numbers for Operations Analytics Predictive Insights and its
prerequisites

Title
eAssembly part
number

IBM Operations Analytics Predictive Insights V1.3.5 Multiplatform
English eAssembly

CJ0PWEN

IBM Operations Analytics Predictive Insights OMNIbus Components
V8.1 Linux English eAssembly

CRS7HML

Prerequisite Versions

The following table lists the versions of the prerequisite software required if you
want to use Operations Analytics Predictive Insights with Dashboard Application
Services Hub.

Table 3. Prerequisite Versions for Dashboard Application Services Hub

Prerequisite Version

IBM DB2 Workgroup Server Edition 10.5 FP3

IBM InfoSphere Streams 3.2

IBM Jazz for Service Management 1.1.2.1

IBM Netcool/OMNIbus Core 8.1.0.5

IBM Netcool/OMNIbus WebGUI 8.1.0.4

IBM Websphere 8.5.5.4

The following table lists the versions of the prerequisite software required if you
want to use Operations Analytics Predictive Insights with Tivoli Integrated Portal.
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Table 4. Prerequisite Versions for Tivoli Integrated Portal

Prerequisite Version

IBM DB2 Workgroup Server Edition 10.5 FP3

IBM InfoSphere Streams 3.2

IBM Netcool/OMNIbus Core 7.4

IBM Netcool/OMNIbus WebGUI 7.4 FP4 *

* FP4 is optional but is the recommended version.

Installation Order

You must install the Operations Analytics Predictive Insights prerequisite software
in the following order:
1. IBM DB2 Workgroup Server Edition 10.5 FP3
2. IBM InfoSphere Streams 3.2
3. IBM Jazz for Service Management 1.1.2.1
4. IBM Netcool/OMNIbus Core 8.1.0.5
5. IBM Netcool/OMNIbus WebGUI 8.1.0.4

Note: If Netcool/OMNIbus is already installed, it is recommended that you
create a new instance for Operations Analytics Predictive Insights.

The order of installation is the same for a single server installation or multi-server
installation.

DB2
DB2 is a requirement of Operations Analytics Predictive Insights.

Document caveat

This installation guide provides a shortened version of the DB2 installation
process.

Note: It must be noted the installation process prescribed in this documentation is
not meant to replace the product-specific documentation. The installation process
here contained for DB2 has been provided for the convenience of the end-user and
should only be used if:
v You are performing a basic install of DB2, accepting all the default options.
v You are performing a trial installation of the Operations Analytics Predictive

Insights product.

You must consult the official DB2 documentation if:
v You intend to use extra options or steps that are not the default as described in

this document.
v You intend to install multiple instances of the required product

The official and complete IBM DB2 Installation instructions and release notes are
available in the DB2 Knowledge Center.

Instructions on installing IBM DB2 using a response file are available in the DB2
Knowledge Center section: Installing a DB2 database product using a response file.
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Install processes

The following are the two options for DB2 installation covered in this document:
v Install DB2 as non-root
v Install DB2 as root

Both of these options are covered in the following sections, only one of these
options is to be pursued.

Information required for Operations Analytics Predictive Insights
installation
The installation process for Operations Analytics Predictive Insights requires that
you have your DB2 installation information at the ready.

The following table lists the DB2 information items that the Operations Analytics
Predictive Insights installer requests as you pursue the installation process. It is a
good practice to make note of all listed items as you install the DB2 database.

Table 5. DB2 details required by Operations Analytics Predictive Insights

Information item Default

DB2 instance user name db2inst1

Operations Analytics Predictive Insights
Database name

SCAPIDB

Operations Analytics Predictive Insights
Database server port number

50000

Operations Analytics Predictive Insights
Database host

Current host

Operations Analytics Predictive Insights
Database user

scadmin

Operations Analytics Predictive Insights
Database user password

Installing DB2 as non-root
DB2 is a requirement of Operations Analytics Predictive Insights.

Before you begin

Verify your operating system user process resource limits (ulimits). If the minimum
ulimit values are not met, the DB2 engine can encounter unexpected operating
resource shortage errors. These errors can lead to a DB2 database system outage.
See the section Operating system user limit requirements (Linux and UNIX) in
the DB2 Knowledge Center for details of the recommended ulimit values.

About this task

The DB2 installer automatically creates and configures a non-root instance during a
non-root installation. As a non-root user, you can customize the configuration of
the non-root instance during the installation. You can also use and maintain the
installed DB2 database product without root privileges. The non-root installation of
a DB2 database product has one DB2 instance with most features enabled by
default.

A non-root installation can be useful for:
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v Enterprises that have thousands of workstations and users who want to install a
DB2 database product without consuming a system administrator's time

v Application developers who are not typically system administrators but use DB2
database products to develop applications

v Independent Software Vendors (ISVs) who develop software that does not
require root user authority yet embeds a DB2 database product

After you install DB2 as a non-root user, it has most of the functions that are
available when you install it as a root user. However, there are some differences
and limitations. You must remove some of the limitations by running the db2rfe
command as a root user.

Before you install any DB2 database product as a non-root user, be aware of the
differences between root installations and non-root installations, and the limitations
of non-root installations. For more information on non-root installation, see
Installing DB2 database servers as a non-root user in the DB2 Knowledge Center.

The following tasks are described in order to allow you install DB2 as a non-root
user:

Procedure
1. Prepare for DB2 installation by installing the required libraries.
2. Install DB2 using the non-root user account.
3. Enabling root-based features in non-root installations with db2rfe
4. If your DB2 installation connection has problems, runs some checks to verify

your installation.

Prepare for DB2 installation as non-root:

You must create the non-root user to carry out the installation of DB2 and add the
required files.

About this task

DB2 can be installed as a non-root user. The ongoing management of DB2 is done
as the DB2 instance owner. Typically the DB2 instance owner is db2inst1.

For more information on DB2 installation prerequisites, see Operating system user
limit requirements (Linux and UNIX) in the DB2 Knowledge Center.

Procedure

1. As db2inst1, copy the DB2 installation software to the directory in which you
want to extract it.

2. Change the permissions on the folder, if necessary, to be owned by db2inst1.
3. As db2inst1, extract the DB2 installation software.

For example:
tar zxvf DB2_10.5.0.3_limited_Lnx_x86-64.tar.gz

Note: The package filename is correct for DB2 installation version
4. As db2inst1, change to the server_r directory and run the DB2 prerequisites

checker script.
For example:
./db2prereqcheck -v 10.5.0.3
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You can ignore alerts in relation to the following:
v /lib/libpam.so*

v rdma

v InfiniBand

v modprobe.conf

v OpenSSH

v log_mtts_per_seg

5. As root, install any packages that are called out as problems by the
db2prereqcheck script.
For example:
yum install dapl
yum install sg3_utils

6. Check if SELINUX is enabled, and if so disable it.
For example:
vi /etc/selinux/config
SELINUX=disabled

7. Restart the server if the SELINUX setting was changed.
8. Modify the kernel parameters as described in the section, Modifying kernel

parameters (Linux) of the DB2 Knowledge Center

DB2 installation as non-root:

Install DB2 as the non-root user db2inst1.

Before you begin

Verify your operating system user process resource limits (ulimits). If the minimum
ulimit values are not met, the DB2 engine can encounter unexpected operating
resource shortage errors. These errors can lead to a DB2 database system outage.
See the section Operating system user limit requirements (Linux and UNIX) in
the DB2 Knowledge Center for details of the recommended ulimit values.

Procedure

1. Log in as the non-root user db2inst1.
2. Change to the directory containing the installation software.

For example:
cd /home/db2inst1/server_r

3. As db2inst1, run the db2setup script:
./db2setup

4. Click Install a Product from the menu on the left of the screen.
5. Click Install New > DB2 Workgroup Server Edition version 10.5 Fix Pack 3.
6. Follow the installation wizard to complete the installation.

What to do next

The DB2 installation script prompts you to set up the DB2 instance environment.
The instructions on how to do this are output by the DB2 installation script. The
steps are best pursued in a new command terminal.
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Enable root-based features in non-root installations with db2rfe:

There are several features and abilities in non-root installations that are initially
unavailable but which can be enabled by running a the db2rfe command.

About this task

There are further limitations on non-root installations that can be overcome by
running the db2rfe command. The following features and abilities are initially
unavailable in non-root installations:
v Operating system-based authentication
v The ability to reserve service names in the /etc/services file

To enable them, use the db2rfe_config_file.cfg available in the unpacked
IOA_PI_1.3.5.tgz

Procedure

To enable the features and abilities that are initially unavailable in non-root
installations:
1. Unpack the Operations Analytics Predictive Insights software,

IOA_PI_1.3.5.tgz, if you have not already done so.
2. Navigate to the predictiveInsightsInstaller1.3.5 directory, that is within the

directory in which you unpacked IOA_PI_1.3.5.tgz.
3. (Optional) Update the sample configuration file, db2rfe_config_file.cfg.

The configuration file is used as input to the db2rfe command. Only update
the sample configuration file provided if you wish to enable more options than
the default file enables.The sample configuration file enables:
v Operating system-based authentication
v The ability to reserve service names in the /etc/services file
If you wish to enable more options, perform the following steps:
a. Copy the sample configuration file, db2rfe_config_file.cfg, to a different

location, for example, /home/db2inst1.
b. Consult DB2 documentation and update the configuration file as preferred.
c. Update the file as appropriate.

4. Stop DB2. As db2inst1, run:
db2stop

5. End the server to client process: As db2inst1, run:
db2 terminate

6. Log in with root user authority.
7. Navigate to the $HOME/sqllib/instance directory, where $HOME represents the

non-root user's home directory.
8. Run the db2rfe command referring to the sample or updated configuration file.

For example:
./db2rfe -f /home/db2inst1/db2rfe_config_file.cfg

Where:
v db2rfe_config_file.cfg is the configuration file provided in the

IOA_PI_1.3.5.tgz file.
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v /home/db2inst1 is the directory to which you copied
db2rfe_config_file.cfg. If you copied this to another directory, please
update the command syntax to refer to your chosen directory.

DB2 post installation tasks:

Configure your DB2 installation so that it is running correctly.

Procedure

1. Stop DB2. As db2inst1, run:
db2stop

2. End the server to client process: As db2inst1, run:
db2 terminate

3. If the port is closed you may need to disable iptables on the DB2 server.
As root, run the following commands:
service iptables stop
/sbin/chkconfig --del iptables

4. Check DB config to ensure SVCENAME is correct.
Run the following command as db2inst1:
db2 get dbm cfg | grep SVCENAME

If SVCENAME does not match "db2c_db2inst1" then update using the
following command:
db2 update dbm cfg using SVCENAME db2c_db2inst1

5. Verify SVCENAME, as seen in step 4, exists for correct port in /etc/services file. If
not then append it to /etc/services file.
db2c_db2inst1 50000/tcp

6. Ensure the communication protocols for DB2 instance uses TCPIP.
As db2inst1, run:
db2set DB2COMM=tcpip

7. Start DB2:
As DB2inst1 run command:
db2start

What to do next

See the section Verifying the installation using the command line processor (CLP) in the
DB2 Knowledge Center to confirm that DB2 was installed correctly.

Installing DB2 as root
DB2 is a requirement of Operations Analytics Predictive Insights.

About this task

DB2 can be installed as root. The ongoing management of DB2 is done as the DB2
instance owner. Typically, the DB2 instance owner is db2inst1.

Procedure
1. Copy the DB2 installation software to the directory in which you want to

extract it.
2. Extract the DB2 installation software.

For example:
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tar zxf DB2_10.5.0.3_limited_Lnx_x86-64.tar.gz

Note: The package filename is correct for DB2 installation version
3. Change to the server_r directory and run the DB2 prerequisites checker

script.
For example:
./db2prereqcheck -v 10.5.0.3

You can ignore alerts in relation to the following:
v /lib/libpam.so*

v rdma

v InfiniBand

v modprobe.conf

4. Install any packages that are called out as problems by the db2prereqcheck
script.
For example:
yum install dapl
yum install sg3_utils

5. Check if SELINUX is enabled, and if so disable it.
For example:
vi /etc/selinux/config
SELINUX=disabled

6. Restart if the SELINUX setting was changed.
7. Modify the kernel parameters as described in the DB2 documentation,

Modifying kernel parameters (Linux)
8. Change to the directory containing the installation software.

For example:
cd /home/db2inst1/server_r

9. Run the db2setup script:
./db2setup

Note: This command opens the DB2 installation wizard and therefore must be
run from a suitable XTERM or VNC window.

10. Click Install a product from the set of options displayed.
11. Click Install New > DB2 Version 10.5 Fix Pack 3 Workgroup, Enterprise and

Advanced Editions.
12. Accept the defaults in the installation wizard until you are prompted to set

user information for the DB2 instance owner. To set the DB instance owner,
click the Existing user radio button and enter db2inst1. Follow the remainder
of the wizard to complete the installation.
Make note of any users and passwords that you specified.
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InfoSphere Streams
InfoSphere® Streams is a requirement of Operations Analytics Predictive Insights.

Infosphere Streams versions

The following versions of Infosphere Streams are supplied with Operations
Analytics Predictive Insights 1.3.5:
v Infosphere Streams 3.2
v Infosphere Streams 4.0.0

To decide which version of Infosphere Streams to install, consider whether you can
use SSH in your environment. It is mandatory to use SSH with Infosphere Streams
3.2, whereas SSH use is optional with Infosphere Streams 4.0.0. It is recommended
that you install Infosphere Streams 3.2 unless you are unable to use SSH in your
environment.

Document caveat

This installation guide provides a shortened version of the InfoSphere Streams
installation process.

Note: These installation instructions are for your convenience and are not meant to
replace the product-specific documentation. Use these instructions only if:
v You are performing a basic installation of InfoSphere Streams, accepting all the

default options.
v You are performing a trial installation of the Operations Analytics Predictive

Insights product.

You must consult the official InfoSphere Streams documentation if:
v You intend to use extra options or steps that are not the default as described in

this document.
v You intend to install multiple instances of the required product.

The official and complete installation and administration information for IBM
InfoSphere Streams can be found in the IBM InfoSphere Streams Knowledge
Center.

Console Installation of IBM InfoSphere Stream can be found in the IBM InfoSphere
Streams Knowledge Center section: Installing InfoSphere Streams.

Information required for Operations Analytics Predictive Insights
installation
The installation process for Operations Analytics Predictive Insights requires that
you have your InfoSphere Streams install information at the ready.

The following table lists the InfoSphere Streams information items that the
Operations Analytics Predictive Insights installer requests as you pursue the
installation process. It is a good practice to make note of the required InfoSphere
Streams installation information.
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Table 6. InfoSphere Streams details required by the Operations Analytics Predictive Insights
installer

Information item Default

InfoSphere Streams user scadmin

InfoSphere Streams user password

InfoSphere Streams installation location /home/scadmin/InfoSphereStreams

Installing InfoSphere Streams 3.2
Installing InfoSphere Streams 3.2 for Operations Analytics Predictive Insights.

Before you begin
1. As root, edit the /etc/selinux/config file to set SELinux to disabled.

A change to this policy requires a restart of the Linux VM/Server
For more information, see Security-Enhanced Linux (SELinux) for IBM InfoSphere
Streams in the IBM InfoSphere Streams Knowledge Center.

2. Ensure that the installing user has executable permissions on the /tmp, /opt,
and /home file systems.

3. Ensure that su from the root user does not require that you enter a password.
4. Check the /etc/hosts file to make sure that the server name is not on the

same line as the loop back address.
For example, if you have an address that looks like:
127.0.0.1 localhost.localdomain localhost <server_name>

Then, remove the server name so that it looks like:
127.0.0.1 localhost.localdomain localhost

You must not remove the loopback address.
5. Enter the following command to check that the sshd service is running:

service sshd status

6. If the sshd service is not running, enter the following command to start it:
service sshd start

7. Ensure that the installing user, for example, scadmin, has full permissions on
the InfoSphere Streams installation software.

8. Change to the scadmin user, for example:
su - scadmin

9. Extract the InfoSphere Streams installation software, for example:
tar zxvf Streams-3.2.0.0-x86_64-el6.tar.gz

10. Change to the directory in which you unpacked the InfoSphere Streams
installation software and as scadmin use the InfoSphere Streams dependency
checker:
cd <streams_unpack_folder>
./dependency_checker.sh

You may receive an alert indicating that the perl-XML-Simple file is missing. If
so, you can find the file in the <streams_unpack_folder>/rpm directory.
To install a missing rpm, run the following command:
yum install <rpm_name>.rpm

To install any missing packages, run the following command:
yum install <package_name>
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Note: If root user permissions are required to install missing files, make sure
that you switch back to your InfoSphere Streams user, scadmin, after you
complete the installation.

Procedure
1. Run the installer as scadmin:

cd <streams_unpack_folder>
./InfoSphereStreamsSetup.bin

Accept all default values presented during setup. When the installation is
complete the Postinstallation Tasks dialog is displayed, which lists the set of
initial configuration tasks for InfoSphere Streams.

2. Run the following tasks only from the First Steps:
v Configure the SSH environment
v Generate public and private keys
v Verify the Installation
If the dialog does not open or must be reopened change to the directory
<streams_unpack_folder> and run FirstSteps.sh, for example:
cd /home/scadmin/InfoSphereStreams
./FirstSteps.sh

3. Add the following line to the .bashrc file for scadmin:
if [ -f /home/scadmin/InfoSphereStreams/bin/streamsprofile.sh ]; then
. /home/scadmin/InfoSphereStreams/bin/streamsprofile.sh
fi

Note: If you did not install InfoSphere Streams in the default location,
/home/scadmin/InfoSphereStreams, enter the actual path to your installation in
the .bashrc file.

4. Save and source the file:
. ~/.bashrc

5. Ensure the version of Java that comes with InfoSphere Streams is the one that
is used at run time:
a. Update the JAVA_HOME and PATH to match the new Java.

For example:
PATH=/home/scadmin/InfoSphereStreams/java/bin:$PATH
JAVA_HOME=/home/scadmin/InfoSphereStreams/java
export PATH JAVA_HOME

Note: Substitute the directory path if you installed InfoSphere Streams to a
different location.

b. Add the JAVA_HOME and PATH variables to the ~scadmin/.bashrc and
~scadmin/.bash_profile files.

6. Modify LD_LIBRARY_PATH by adding the following line to the ~scadmin/.bashrc
file:
export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib64:/usr/lib

Installing InfoSphere Streams 4.0.0
Installing InfoSphere Streams 4.0.0 for Operations Analytics Predictive Insights. It
is recommended that you install InfoSphere Streams 4.0.0 only if you cannot use
SSH, which is mandatory with InfoSphere Streams 3.2.
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Before you begin
1. As root, edit the /etc/selinux/config file to set SELinux to disabled.

A change to this policy requires a restart of the Linux VM/Server
For more information, see Security-Enhanced Linux (SELinux) for IBM InfoSphere
Streams in the IBM InfoSphere Streams Knowledge Center.

2. Ensure that the installing user has executable permissions on the /tmp, /opt,
and /home file systems.

3. Ensure that su from the root user does not require that you enter a password.
4. Check the /etc/hosts file to make sure that the server name is not on the same

line as the loop back address.
For example, if you have an address that looks like:
127.0.0.1 localhost.localdomain localhost <server_name>

Then, remove the server name so that it looks like:
127.0.0.1 localhost.localdomain localhost

You must not remove the loopback address.
5. Ensure that the installing user, for example, scadmin, has full permissions on

the InfoSphere Streams installation software.
6. Change to the scadmin user, for example:

su - scadmin

7. Extract the InfoSphere Streams installation software, for example:
tar zxvf IS_STRM_4.0.0_RHEL6_EN.tar.gz

8. Change to the directory in which you unpacked the InfoSphere Streams
installation software and as scadmin use the InfoSphere Streams dependency
checker:
cd <streams_unpack_folder>
./dependency_checker.sh

You may receive an alert indicating that the perl-XML-Simple file is missing. If
so, you can find the file in the <streams_unpack_folder>/rpm directory.
To install a missing rpm, run the following command:
yum install <rpm_name>.rpm

To install any missing packages, run the following command:
yum install <package_name>

Note: If root user permissions are required to install missing files, make sure
that you switch back to your InfoSphere Streams user, scadmin, after you
complete the installation.

Procedure
1. Run the installer as scadmin:

cd <streams_unpack_folder>
./InfoSphereStreamsSetup.bin

Accept all default values presented during setup.
2. When the installation is complete, the installer prompts you to open the

Domain Manager UI. You do not need to open the UI as the Operations
Analytics Predictive Insights start script, start.sh, creates a domain when it is
run.

3. Add the following line to the .bashrc file for scadmin:
if [ -f /home/scadmin/InfoSphereStreams/bin/streamsprofile.sh ]; then
. /home/scadmin/InfoSphereStreams/bin/streamsprofile.sh
fi
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Note: If you did not install InfoSphere Streams in the default location,
/home/scadmin/InfoSphereStreams, enter the actual path to your installation in
the .bashrc file.

4. Save and source the file:
. ~/.bashrc

5. Ensure the version of Java that comes with InfoSphere Streams is the one that
is used at run time:
a. Update the JAVA_HOME and PATH to match the new Java.

For example:
PATH=/home/scadmin/InfoSphereStreams/java/bin:$PATH
JAVA_HOME=/home/scadmin/InfoSphereStreams/java
export PATH JAVA_HOME

Note: Substitute the directory path if you installed InfoSphere Streams to a
different location.

b. Add the JAVA_HOME and PATH variables to the ~scadmin/.bashrc and
~scadmin/.bash_profile files.

6. Modify LD_LIBRARY_PATH by adding the following line to the ~scadmin/.bashrc
file:
export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/lib64:/usr/lib

Jazz for Service Management
You must install IBM Jazz™ for Service Management 1.1.2.1 unless you already
installed Tivoli® Integrated Portal with OMNIbus WebGUI 7.4.

To visualize the events generated by Operations Analytics Predictive Insights, you
can use Dashboard Application Services Hub, which is bundled with Jazz for
Service Management.

The installation procedure described in this section is a shortened version of the
Jazz for Service Management installation. For more information on how to install
Jazz for Service Management, see the Jazz for Service Management Knowledge
Center.

Installing Jazz for Service Management
Instructions on how to install Jazz for Service Management so that it can be used
with Operations Analytics Predictive Insights.

Procedure
1. Download and extract the following files:
v JAZZ_FOR_SM_1.1.2.1_FOR_LNX.zip

v IBM_WAS_FOR_JSM_FOR_LNX_ML.zip

Extract both files to a directory on the server on which you plan to install Jazz
for Service Management.

2. Complete the following steps to run the prerequisite scanner.
a. Navigate to the directory in which you extracted the Jazz for Service

Management zip file.
b. To start launchpad, enter the following command:

./launchpad.sh

c. Click Tools > IBM Prerequisite Scanner > Run

d. Resolve any failures in the following sections:
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v DSH - Dashboard Application Services Hub in JazzSM
v ODP - Common prerequisites in JazzSM

Note: You can ignore failures in other sections of the scanner output. For
example:
network.availablePorts.db2instance FAIL PortsInUse:631,6001,60001,5901,523... 50000
os.servicesTCPavailablePorts.db2instance FAIL PortsInUse:50000 50000
DBType FAIL DB2 DB2ShdNotBeInstalled

If you run the prerequisite scanner as a non-root user, you can ignore the
following failure:
user.isAdmin FAIL False True

3. Complete the following steps to install Jazz for Service Management.
a. Navigate to the directory in which you extracted the Jazz for Service

Management zip file.
b. To start launchpad, enter the following command:

./launchpad.sh

c. Click Tools > Installation Manager.
d. Enter the location of IBM WebSphere® Application Server package

repository. For example, <extract_directory>/WASRepository/disk1/
diskTag.inf

e. Click Run.
f. When Installation Manager launches, click Install.
g. Install the following packages:
v IBM WebSphere Application Server
v Jazz for Service Management extensions for IBM WebSphere 8.5
v IBM Dashboard Application Service Hub
v IBM WebSphere SDK Java™ Technology Edition

h. Complete the Installation. When prompted to choose a program to start,
select None.

Note: The JazzSM installer creates the required profile so you do not need
to create a profile when prompted to do so at the end of the installation.

4. Complete the following steps to configure Jazz for Service Management to
support TLS 1.2.
a. To log in to Dashboard Application Services Hub, type the following URL:

https://<host>:<port>/ibm/console/logon.jsp

where <host> is the host name of the Dashboard Application Services Hub
server and <port> is the port number. The default port number is 16311.

b. Click Console Settings > WebSphere Administrative Console.
c. Click Launch WebSphere Administrative Console.
d. Click Security > SSL certificate and key management > SSL

configurations > NodeDefaultSSLSettings > Quality of protection (QoP)
settings

e. In the Protocol field, select TLSv1.2.
f. Click Apply.
g. Click Save.
h. Edit the <JAZZ_Profile_Home>/properties/ssl.client.props file, where

JAZZ_Profile_Home is /opt/IBM/JazzSM/profile by default.

20 IBM Operations Analytics Predictive Insights: Installation Guide



i. Update the value of the com.ibm.ssl.protocol field to TLSv1.2. For example:
com.ibm.ssl.protocol=TLSv1.2

Information required for Operations Analytics Predictive Insights
installation
The installation process for Operations Analytics Predictive Insights requires that
you have your Jazz for Service Management install information at the ready.

The following table lists the Jazz for Service Management information items that
the Operations Analytics Predictive Insights installer requests as you pursue the
installation process. It is a good practice to make note of the required Jazz for
Service Management installation information.

Table 7. Jazz for Service Management details required by the Operations Analytics
Predictive Insights installer

Information item Default

Jazz for Service Management / Dashboard
Application Services Hub hostname

User name and password of Dashboard
Application Services Hub installer

Dashboard Application Services Hub
installation location

/opt/IBM/JazzSM

Dashboard Application Services Hub profile
user name and password

Netcool/OMNIbus
Netcool/OMNIbus is a required integration item for Operations Analytics
Predictive Insights.

Document caveat

This installation guide provides a shortened and more basic version of the
Netcool/OMNIbus installation process.

Note: The installation process prescribed in this documentation is not meant to
replace the product-specific, comprehensive Netcool/OMNIbus installation
documentation. The installation process here contained for Netcool/OMNIbus has
been provided for the convenience of the end-user and should only be used if:
v You are performing a basic install of Netcool/OMNIbus, accepting all the

default options.
v You are performing a trial installation of the Operations Analytics Predictive

Insights product.

You must consult the official Netcool/OMNIbus documentation if:
v You intend to use extra options or steps that are not the default as described in

this document.
v You intend to install multiple instances of the required product.
v You intend to pursue a silent, console or other installation type that is not the

default as described in this document.

Chapter 2. Preparing to install 21



The official and complete Installation and administration information for
Netcool/OMNIbus can be found in the Tivoli Netcool/OMNIbus Knowledge
Center.

Console installation instructions for Netcool/OMNIbus can be found in the Tivoli
Netcool/OMNIbus Knowledge Center section: Installing in console mode (UNIX and
Linux).

Information required for Operations Analytics Predictive Insights
installation
The installation process for Operations Analytics Predictive Insights requires that
you have certain Netcool/OMNIbus and Netcool/OMNIbus WebGUI installation
information at the ready.

The following table lists the Netcool/OMNIbus and Netcool/OMNIbus WebGUI
information items that the Operations Analytics Predictive Insights installer will
request as you pursue the installation process. It is a good practice to make note of
all information items as you install Netcool/OMNIbus and Netcool/OMNIbus
WebGUI.

Table 8. Netcool/OMNIbus and Netcool/OMNIbus WebGUI details required by the
Operations Analytics Predictive Insights installer

Information item Default

OMNIbus server host name Current host

OMNIbus server port number 4100

OMNIbus Object Server name NCOMS

OMNIbus admin user name root

OMNIbus admin user password Note: It is possible to leave this password as
an empty string. Entering this password
incorrectly is not flagged immediately within
the Operations Analytics Predictive Insights
installer, but results in certain components
not installing correctly.

Directory where WAAPI is installed /opt/IBM/tivoli/netcool/omnibus_webgui/
waapi

Table 9. Tivoli Integrated Portal details required by the Operations Analytics Predictive
Insights installer

Information item Default

Directory where Tivoli Integrated Portal is
installed

/opt/IBM/tivoli/tipv2

Tivoli Integrated Portal user name tipadmin

Tivoli Integrated Portal user password

Installing the OMNIbus ObjectServer
The OMNIbus ObjectServer is the standard event management system that
Operations Analytics Predictive Insights can use.

Before you begin
1. Download and install the OMNIbus prerequisite scanner to make sure you

have all the OMNIbus requirements in place before you begin the installation.
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The prerequisite scanner can be downloaded from Tivoli Netcool/OMNIbus
Knowledge Center section IBM Prerequisite Scanner.

2. Run the prerequisite scanner to discover if there are any missing items that
must be installed.

3. Install all packages which are marked as missing.

About this task

OMNIbus ObjectServer can be installed either by root or by a non-root user. If you
choose to install as a non-root user, ensure the appropriate permissions on the
install software and target location are given to the chosen non-root user. If you
install as root, the ongoing management of OMNIbus must be done as root.

Note: If your OMNIbus and your Operations Analytics Predictive Insights
Analytics component are on the same server and owned by the same user, do not
set the NCHOME variable. This is in line with the Tivoli Netcool/OMNIbus
Knowledge Center section Setting Tivoli Netcool/OMNIbus environment variables
(UNIX and Linux). The NCHOME environment variable specifies the home location for
Tivoli Netcool/OMNIbus. Setting NCHOME may cause the probe to point to the
wrong location and not run.

Procedure
1. Copy the OMNIbus ObjectServer installation software, OMNIbus-v8.1.0.5-

Core.linux64.zip , to an empty directory.
2. Extract the zip file:

unzip OMNIbus-v8.1.0.5-Core.linux64.zip

Note: The package filename is correct for .
3. Start the graphical user interface installation wizard:

./install_gui.sh

4. Follow the installation wizard to complete the installation, selecting the default
options.

Note: When prompted, to choose which program to start, select None.

What to do next
1. After you have completed the installation, use the following command to test if

all prerequisites are met for the OMNIbus ObjectServer:
ldd /opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/bin*/nco* | grep "not found"

2. To ensure that the ldd command resolves all dependent libraries, set the
LD_LIBRARY_PATH both in the current shell and in ~/.bashrc.
The following is an example of how this might be done:
export LD_LIBRARY_PATH=/usr/lib64:/lib64:/opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/lib64:
/opt/IBM/tivoli/netcool/platform/linux2x86/lib64:/usr/lib:/lib:
/opt/IBM/tivoli/netcool/omnibus/platform/linux2x86/lib:
/opt/IBM/tivoli/netcool/platform/linux2x86/lib:$LD_LIBRARY_PATH

3. Install any prerequisites that are identified as missing.

Configuring the OMNIbus ObjectServer
When the Omnibus initial installation is complete and before you install OMNIbus
WebGUI, you must configure the ObjectServer.
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Procedure
1. Change to the directory /opt/IBM/tivoli/netcool/etc.
2. Make a copy of the omni.dat file.

For example, run the commend
mv omni.dat omni.dat.ORIG

3. Run the command:
sed s/omnihost/<yourObjServHost>/g omni.dat.ORIG > omni.dat

4. Change to the directory /opt/IBM/tivoli/netcool/bin.
5. Run the command:

./nco_igen -out /opt/IBM/tivoli/netcool/etc/interfaces

6. Change to the directory /opt/IBM/tivoli/netcool/omnibus/bin.
7. Run the following commands:

./nco_dbinit

Results

Configuration of the OMNIbus ObjectServer is now complete and it is ready to be
started

Starting the OMNIbus ObjectServer
When the OMNIbus initial installation is complete and before you install
OMNIbus WebGUI, you must start the ObjectServer.

Procedure
1. Change to the /opt/IBM/tivoli/netcool/omnibus/bin directory.
2. To start the ObjectServer, enter the following command:

nohup ./nco_objserv &

3. To confirm that the ObjectServer is running, enter the following command:
./nco_sql -user root

When prompted for a password, enter the OMNIbus root user password or
press enter if the password is blank.
A successful login confirms that the ObjectServer is running.

4. To exit, type quit.

Installing OMNIbus WebGUI
OMNIbus WebGUI is a set of visualization tools for OMNIbus that allow you to
monitor and manage events.

About this task

You must use the same user that was used to install Jazz for Service Management.
OMNIbus WebGUI can be installed by root or a non-root user. Ensure the
appropriate permissions on the installation software and target location are given
to the non-root user if you choose to install as non-root.

Procedure
1. Ensure that both Jazz for Service Management and the OMNIbus ObjectServer

that you installed are started.
2. Copy the OMNIbus WebGUI installation software, OMNIbus-v8.1.0.4-

WebGUI.linux64.zip, to an empty directory.
3. Extract the zip file:
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unzip OMNIbus-v8.1.0.4-WebGUI.linux64.zip

4. Change to the /eclipse subdirectory of the Installation Manager installation
directory and use the following command to start Installation Manager
./IBMIM

To record the installation steps in a response file for use with silent installations
on other computers, use the -record response_file option. For example:
./IBMIM -record install_1.xml

5. From the main menu, click File > Preferences.
6. Click Add Repository. Click Browse and go to the ...WebGUI/

OMNIbusWebGUIRepository/repository.config repository.
7. Click OK.
8. Click Install.
9. Follow the installation wizard to complete the installation. Select the default

options and record any users and passwords that you enter.

Note: You must add the WebGUI users that are created in the post installation
steps to an ObjectServer repository and not a file repository.

What to do next

At the end of the WebGUI installation, click Run the OMNIbus Web GUI
Configuration Tool and use the tool to configure WebGUI to point to your
OMNIbus ObjectServer. In the tool wizard, replace localhost with the Fully
Qualified Domain name of the ObjectServer. If necessary, update the port details
for the ObjectServer connection and accept the defaults for the remaining
configuration options.
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Chapter 3. Installing Operations Analytics Predictive Insights

Use IBM Installation Manager to install or update Operations Analytics Predictive
Insights.

You can install an Operations Analytics Predictive Insights component only on the
server on which you are running the IBM Installation Manager. You can use IBM
Installation Manager in administrator, nonadministrator, or group mode to install
Operations Analytics Predictive Insights.

Table 10. Installation Manager user modes

Mode Description

administrator You can use administrator mode when you
have root privileges. In administrator mode,
you can use Installation Manager to install
Operations Analytics Predictive Insights in a
common location that is accessible by all
users on a system. You can install only one
administrator instance of Installation
Manager on a computer. If you run the
install.sh from the
predictiveInsightsInstaller1.3.5 folder as
root, Installation Manager starts in
administrator mode.

nonadministrator In nonadministrator mode, you can install
Operations Analytics Predictive Insights in a
location that is accessible only by the user
who installs Installation Manager. You can
install only one instance of Installation
Manager for each user on a computer. If you
run the install.sh from the
predictiveInsightsInstaller1.3.5 folder as
a non-root user, Installation Manager starts
in nonadministrator mode.
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Table 10. Installation Manager user modes (continued)

Mode Description

group In group mode, you can use Installation
Manager to install Operations Analytics
Predictive Insights as any user in a Linux
group. However, you can update the
Operations Analytics Predictive Insights
installation only as the same user that
completed the initial installation.

To install Operations Analytics Predictive
Insights in group mode, you must first
install Installation Manager in group mode
and then start Installation Manager in group
mode. For more information, see the
Installation Manager documentation on
IBM® Knowledge Center.After you start
Installation Manager in group mode, add the
Operations Analytics Predictive Insights
repository from the
predictiveInsightsInstaller1.3.5/
offering directory and follow the standard
installation instructions for Operations
Analytics Predictive Insights.

To

Selecting user accounts to install components
You can use the same user account to install all Operations Analytics Predictive
Insights components. For example, you can use the scadmin account that you
created earlier.

If you wish to use different accounts to install Operations Analytics Predictive
Insights components, you must observe the following rules when selecting
accounts:
v The database component must be installed by a user who has permissions to

create a database in the DB2 instance that is installed.
v The Analytics component and Mediation Tool component must be installed by

the same user that installed InfoSphere Streams.
v If you plan to use Tivoli Integrated Portal to display anomaly events, the UI

component must be installed by the same user that installed WebGUI and Tivoli
Integrated Portal.

Creating the installation directory
You must create the directory where you want to install Operations Analytics
Predictive Insights. For example, to create a directory /opt/IBM/scanalytics:

Procedure
1. Enter the following command:

mkdir /opt/IBM/scanalytics

2. Ensure that each user account that will be used to install Operations Analytics
Predictive Insights on the server has read, write and execute permissions on
this directory.
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Setting the JAVA_HOME variable
Set JAVA_HOME for the required users.

About this task

The JAVA_HOME setting is best placed in the user's ~/.bash_profile, or similar
profile file.

Note: If you are aware that non-default locations are used, then you must adjust
accordingly the JAVA_HOME variable accordingly.

On the server to which you going to install the Operations Analytics Predictive
Insights Analytics component, for the IBM InfoSphere Streams administrator, which
by default is scadmin, set the JAVA_HOME variable.

Procedure
v Ensure the version of Java that comes with InfoSphere Streams is the one that is

used at run time:
1. Update the JAVA_HOME and PATH to match the new Java.

For example:
PATH=/home/scadmin/InfoSphereStreams/java/bin:$PATH
JAVA_HOME=/home/scadmin/InfoSphereStreams/java
export PATH JAVA_HOME

Note: Substitute the directory path if you installed InfoSphere Streams to a
different location.

2. Add the JAVA_HOME and PATH variables to the ~scadmin/.bashrc and
~scadmin/.bash_profile files.

v If you are installing the Operations Analytics Predictive Insights Analytics
component as root, you must also set the JAVA_HOME variable to InfoSphere
Streams Java, as described in the previous step, for root user.

Extracting the OMNIbus ObjectServer Signer Certificate to a file
If the OMNIbus ObjectServer to which Operations Analytics Predictive Insights
forwards alarms uses the Secure Sockets Layer (SSL) protocol, you must configure
Operations Analytics Predictive Insights to connect to the ObjectServer over SSL.

About this task

You can configure alarm forwarding to an OMNIbus ObjectServer when you are
installing the Operations Analytics Predictive Insights Analytics component. If the
ObjectServer requires an SSL connection, you must specify the directory path to the
SSL certificate that the ObjectServer uses. Before you install the Analytics
component, you must export the ObjectServer certificate to a file so you can
specify the directory path to the file when you install the Analytics component.

Procedure
1. To log in to your Visualization application, Dashboard Application Services

Hub or Tivoli Integrated Portal, type the following URL:
https://<host>:<port>/ibm/console/logon.jsp
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where <host> is the host name of the server that your visualization
application runs on and port is the port number that the application listens
on. The default port number is as 16311.

2. Click Console Settings > WebSphere Administrative Console.
3. Click Launch WebSphere Administrative Console.
4. Click Security > SSL Certificate and key management > > Key stores and

certificates.

5. Click NodeDefaultTrustStore.
6. Click Signer Certificates.
7. Click Retrieve from port.
8. In the Host field, enter the host name of the OMNIbus ObjectServer.
9. In the Port, enter the SSL port number that is used by the OMNIbus

ObjectServer.
10. In the Alias field, enter an alias for the OMNIbus ObjectServer. You can enter

an arbitrary string, which becomes the name of the credentials.
11. Click Apply.
12. Click Save.
13. Click Signer Certificates.
14. Click Extract.
15. In the File name field, assign a name to the certificate file.
16. Click Apply.

Installing Operations Analytics Predictive Insights on a single server
Installing all the Operations Analytics Predictive Insights components on one
server.

Before you begin

Make sure that you have copied the installation package to the server. Also, ensure
that you have configured a domain name for your server. During the installation of
the UI component, you are required to specify a single sign-on domain.

You can install all Operations Analytics Predictive Insights components under a
single user account through one instance of the IBM Installation Manager, or you
can use separate user accounts. If you wish to use separate accounts, see the rules
for using separate accounts in “Selecting user accounts to install components” on
page 28.

Note: The installation script can install components only to the server on which it
is running.

Procedure
1. Log in as the appropriate user and do the following:

a. Open an xterm window on the server on which you are installing
Operations Analytics Predictive Insights.

b. Navigate to the directory that contains the extracted Operations Analytics
Predictive Insights installation package.

c. Change to the predictiveInsightsInstaller1.3.5 directory.
d. Enter the command ./install.sh.

The IBM Installation Manager is opened.

30 IBM Operations Analytics Predictive Insights: Installation Guide



e. Click the Install option.
The IBM Installation Manager displays the local installation packages.

f. Select IBM Operations Analytics Predictive Insights and click Next.
g. On the Licenses page, read the license agreements for Operations

Analytics Predictive Insights. If you agree to the terms of all the license
agreements, click I accept the terms in the license agreements and then
click Next.

h. On the Location page, in the Shared Resources Directory field, type the
path for the shared directory. The suggested default directory is
/opt/IBM/scanalytics/install_<user>/shared.
The IBM Installation Manager provides the ability to share components
across products. Operations Analytics Predictive Insights does not share
components with any other product. It is a requirement of the IBM
Installation Manager that a shared directory be provided when you install
it. The shared directory must be unique for each user who installs the IBM
Installation Manager on the same server.

i. Click Next.
j. On the Location page, Create a new package group is the only available

option for Operations Analytics Predictive Insights.
In the Installation Directory field, type the path for the installation files.
We suggest using default directory of /opt/IBM/scanalytics/
install_<user>/installer and then click Next.
If you choose to change Installation Directory from the default, note that
the Installation Directory must be unique for each user who installs the
IBM Installation Manager on the same server.
The IBM Installation Manager displays all Operations Analytics Predictive
Insights components that can be installed.

2. If you are installing all components under the same user account, select
Database, Analytics, Mediation tool, and UI. If you want to use different user
accounts to install components, select the component(s) you want to install
under the current user account. Click Next. The IBM Installation Manager
displays each distinct set of required information under a heading.

3. At Database configuration, enter the required information.
Note the following points:
v Update to create DB on a specific location: Optional setting by which you

can specify an install location for the database that is not the default DB2
location. The directory must exist and be owned by the DB2 instance user.

4. Click Validate to confirm all settings are correct.
5. Click Analytics configuration and enter the required information.

One of the required information items is a new topic name. The topic name
must be one word consisting of alphanumeric characters, the underscore
character can also be used, that is, '_', and the name must be between 3 and 10
characters long.#
You must deploy each model that you create to a topic. Topics allow you to
segment your data in ways that are relevant to your business. For example,
you can use a topic to group data that originates from a specific service,
application, or geography. The anomalies generated based on your data can
then be grouped and displayed by topic.

6. Click Validate to confirm all settings are correct.
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7. If you want to integrate Operations Analytics Predictive Insights with
OMNIbus, click Omnibus connection configuration and enter the required
information.

Note: If you have a multi-tiered OMNIbus environment, for example, a
collection ObjectServer, an aggregation ObjectServer, and a display
ObjectServers, you can configure alarm forwarding to any one of these
ObjectServers during the installation. After you complete the installation, and
before extracting any data, you must run the configure_omnibus command
against each ObjectServer in the environment.

For more information, see Configuring alarm forwarding from the Analytics server
to an OMNIbus ObjectServer in the Configuration and Administration Guide.
If the OMNIbus ObjectServer requires a Secure Sockets Layer (SSL)
connection, you must specify the directory path to ObjectServer's SSL
certificate.

8. Click Validate to confirm all settings are correct.
9. Click UI configuration.

You must select the application you wish to use to display anomalies
generated by Operations Analytics Predictive Insights:
v Tivoli Integrated Portal (TIP)
v Dashboard Application Services Hub (DASH)
Enter the required information for the application you have selected.
When you select the Dashboard Application Services Hub (DASH) option
you must also enter UI WebGUI configuration details, and UI local
configuration details. The majority of items are populated by default, but you
should note the following:
v Enter DASH profile user/password: This must be populated by the user

profile you created when installing Dashboard Application Services Hub.
v Enter single sign on key file password: If you have configured single sign

on (SSO) for the IBM WebSphere server on which Dashboard Application
Services Hub is installed, enter the keyfile password used when SSO was
configured. If SSO has never been configured previously, then specify a new
password and note for any possible future configuration.

v Enter single sign-in domain: This entry allows the installer to validate that
both the UI component (for Dashboard Application Services Hub) and the
Dashboard Application Services Hub itself are on servers that are in the
same domain.

v UI WebGUI Config: Populate Enter WebGUI user with the user details of
the user that installed WebGUI, this is a user that has administrative access
to WebGUI. Populate Enter OMNIbus user with the user details of the user
that installed OMNIbus.

Note: If you specify a WebGUI user other than ncoadmin, ensure that the
particular user exists in Omnibus and has appropriate access before you
proceed with the UI installation. If the WebGUI user does not exist in
Omnibus, the installation of Dashboard Application Services Hub fails.

10. Click Validate to confirm all settings are correct.
11. Click Mediation tool configuration and enter the required information.
12. Click Validate to confirm all settings are correct.
13. Click Next. The IBM Installation Manager displays the installation summary

information.
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14. Click Install.

Note: If you chose not to install all components under the current logged in
user account, in step 2, you must repeat this procedure to install each
remaining component under the desired user account.

Installing Operations Analytics Predictive Insights on multiple servers
How to install Operations Analytics Predictive Insights on multiple servers.

You can install the Operations Analytics Predictive Insights components on
multiple servers. In a multi-server installation, you must comply with certain rules
when deciding how to distribute components. For more information, see supported
topologies.

Note: You can only install an Operations Analytics Predictive Insights component
on the server on which you are running the IBM Installation Manager. Remote
installation of components is not supported.

Installation order for a distributed installation
The order in which you must install components when Operations Analytics
Predictive Insights is distributed on multiple servers.

If you plan to install the Operations Analytics Predictive Insights components on
separate servers, you must install the components in the following order:
v Database
v Analytics
v UI

If you plan to partially distribute components, you can combine the installation of
some components depending on how they are distributed:
v Database and Analytics components on same server, UI on separate server.

– If you plan to use the same user account to install both the Database and
Analytics components, you can install both components at the same time. The
Installation Manager automatically installs the Database first. After the
Database and Analytics components are installed, install the UI component.

v Database and UI components on same server, Analytics on separate server.
– Install the Database component first. Next, install the Analytics component.

Finally, install the UI component. If you plan to use the same user account to
install both the Database and UI components, you must use the modify
option in Installation Manager to install the UI.

v Analytics and UI component on same server, Database on separate server
– Install the Database component first. If you plan to use the same user account

to install both the Analytics and UI components, you can install both
components at the same time. The Installation Manager automatically
completes the Analytics installation first.
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GUI installation
Installing Operations Analytics Predictive Insights with the Installation Manager
GUI.

Installing the Database component
You must complete the following steps to install the Database component using the
IBM® Installation Manager User Interface (UI).

Before you begin

The Operations Analytics Predictive Insights Database component can be installed
by the database owner or by the root user.

Note: The installation script can install components only to the server on which it
is running. Copy the installation package to the server on which you are installing
the Database component.

Procedure
1. As the database owner, root, or a user that is part of the same group as the

database owner, for example, scadmin, open an xterm window on the server.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Change to the predictiveInsightsInstaller1.3.5 directory.
4. Enter the command ./install.sh.

The IBM Installation Manager is opened.
5. Click the Install option.

The IBM Installation Manager displays the local installation packages.
6. Select IBM Operations Analytics Predictive Insights and click Next.
7. On the Licenses page, read the license agreements for Operations Analytics

Predictive Insights. If you agree to the terms of all the license agreements,
click I accept the terms in the license agreements and click Next.

8. On the Location page, in the Shared Resources Directory field, type the path
for the shared directory. The default directory is /opt/IBM/scanalytics/
install_<user>/shared.
The IBM Installation Manager can share components across products.
Operations Analytics Predictive Insights does not share components with any
other product. It is a requirement of the IBM Installation Manager that a
shared directory is provided when you install it. The shared directory must be
unique for each user who installs the IBM Installation Manager on the same
server.

9. Click Next.
10. On the Location page, Create a new package group is the only available

option for Operations Analytics Predictive Insights.
11. In the Installation Directory field, type the path for the installation files and

click Next. It is recommended that you use the default directory of
/opt/IBM/scanalytics/install_<user>/installer.
If you choose to change Installation Directory from the default, the
Installation Directory must be unique for each user who installs the IBM
Installation Manager on the same server.
The IBM Installation Manager displays all Operations Analytics Predictive
Insights components that can be installed.
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12. By default, all components are selected for installation. Clear the check box
beside each component other than Database and click Next. The IBM
Installation Manager displays each distinct set of details required under a
heading.

13. Click Database creation configuration and enter the requested information.
The Update to create DB on a specific location is an optional setting that you
can use to specify an installation location for the database that is not the
default DB2 location. The directory must exist and be owned by the DB2
instance user.

14. Click Validate to confirm that all settings are correct.
15. Click Next. The IBM Installation Manager displays the installation summary

information.
16. Click Install.

Installing the Analytics component
You must complete the following steps to install the Analytics component using
the IBM® Installation Manager User Interface (UI).

Before you begin

Ensure that the installation package is on the server on which you are installing
the Analytics component.

Ensure that the server has the following prerequisites installed:
v
v . This prerequisite is installed automatically when you install IBM® InfoSphere®

Streams.

About this task

The Operations Analytics Predictive Insights Analytics component can be installed
by the InfoSphere Streams administrator, which was set to be scadmin during the
InfoSphere Streams installation, or by the root user.

Note: The installation script can install components only to the server on which it
is running.

It is recommended that you install the Mediation tool on any server that you
install the Analytics component and that you use the same user account to install
both.

The Operations Analytics Predictive Insights Database component must be
installed before the Analytics component can be installed. If you install the
Database and Analytics components together, the Installation Manager
automatically completes the Database installation first.

Procedure
1. As the scadmin or root user, open an xterm window on the server on which

you want to install the Analytics component.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Change to the predictiveInsightsInstaller1.3.5 directory.
4. Enter the following command: ./install.sh
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The IBM Installation Manager is launched.
5. If there is no other Operations Analytics Predictive Insights component

installed on the server or if a component was installed with a different user
account to that which you are using to install the Analytics component, click
the Install option and complete steps a to o to install the Analytics component:
a. After you click the Install option, the IBM Installation Manager displays the

local installation packages. Select IBM Operations Analytics Predictive
Insights and click Next.

b. On the Licenses page, read the license agreements for Operations Analytics
Predictive Insights. If you agree to the terms of all the license agreements,
click I accept the terms in the license agreements and click Next.

c. On the Location page, in the Shared Resources Directory field, type the
path for the shared directory. The suggested default directory is
/opt/IBM/scanalytics/install_<user>/shared.
The IBM Installation Manager can share components across products.
Operations Analytics Predictive Insights does not share components with
any other product. It is a requirement of the IBM Installation Manager that
a shared directory is provided when you install it. The shared directory
must be unique for each user who installs the IBM Installation Manager on
the same server.

d. Click Next.
e. On the Location page, Create a new package group is the only available

option for Operations Analytics Predictive Insights.
f. In the Installation Directory field, type the path for the installation files and

click Next. It is recommended that you use the default directory of
/opt/IBM/scanalytics/install_<user>/installer. If you want to change the
default Installation Directory, note that the Installation Directory must be
unique for each user who installs the IBM Installation Manager on the same
server. The IBM Installation Manager displays all Operations Analytics
Predictive Insights components that can be installed.

g. By default, all components are selected for installation. Clear the check box
beside each component other than Analytics and click Next. The IBM
Installation Manager displays each distinct set of information required
under a heading.

h. Click Database connection configuration and enter the required
information.

i. Click Validate to confirm all settings are correct.
j. Click Analytics configuration and enter the required information.

One of the required information items is a new topic name. The topic name
must be a single word between 3 and 10 characters long. It can contain
alphanumeric characters and the underscore character.
You must deploy each model that you create to a topic. Topics allow you to
segment your data in ways that are relevant to your business. For example,
you can use a topic to group data that originates from a specific service,
application, or geography. The anomalies generated based on your data can
then be grouped and displayed by topic.

k. Click Validate to confirm that all settings are correct.
l. If you want to integrate Operations Analytics Predictive Insights with

OMNIbus, click Omnibus connection configuration and enter the required
information.
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Note: If you have a multi-tiered OMNIbus ObjectServer environment, for
example, a collection ObjectServer, an aggregation ObjectServer, and a
display ObjectServer, you can configure alarm forwarding to any one of
these ObjectServers during the installation. After you complete the
installation, and before extracting any data, you must run the
configure_omnibus command against each ObjectServer in the environment.

For more information, see Configuring alarm forwarding from the Analytics
server to an OMNIbus ObjectServer in the Configuration and Administration
Guide.

If the OMNIbus ObjectServer requires a Secure Sockets Layer (SSL)
connection, you must specify the directory path to ObjectServer's SSL
certificate.

m. Click Validate to confirm that all settings are correct.
n. Click Next. The IBM Installation Manager displays the installation summary

information.
o. Click Install.

6. If another Predictive Insights component was installed on the server with the
same user account that you are using to install the Analytics component, click
the Modify option and complete steps a to f to install the Analytics component.
a. After you click the Modify option, the IBM Installation Manager displays

the local installation packages.
b. Select IBM Operations Analytics Predictive Insights and click Next.
c. Select Analytics and click Next.

Note: The check box beside any component that was previously installed is
automatically checked. Do not clear the check box beside any component
that was previously installed as this action causes the component to be
uninstalled during the modify operation.

d. If you want to integrate Operations Analytics Predictive Insights with
OMNIbus, click Omnibus connection configuration and enter the required
information.

Note: If you have a multi-tiered OMNIbus ObjectServer environment, for
example, a collection ObjectServer, an aggregation ObjectServer, and a
display ObjectServer, you can configure alarm forwarding to any one of
these ObjectServers during the installation. After you complete the
installation, and before extracting any data, you must run the
configure_omnibus command against each ObjectServer in the environment.

For more information, see Configuring alarm forwarding from the Analytics
server to an OMNIbus ObjectServer in the Configuration and Administration
Guide.

e. Click Next.
f. Click Modify.
g. Click Finish when the modify operation is complete.
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What to do next

The Operations Analytics Predictive Insights version 1.3.5 analytics component is
designed to handle the significant volume of KPIs that are typically generated by a
large enterprise. For more information on the number of KPIs supported, see the
Performance and Sizing wiki.

To add further Analytics instances to your Operations Analytics Predictive Insights
installation.
1. Make sure the server that is to host the new Analytics component has the

required prerequisites installed, as described in the Before you begin section.
2. Install the Analytics component as described in the Procedure section.
3. Install the Mediation tool to the same server as the new Analytics component,

as described in “Installing the Mediation Tool” on page 41.

You must create at least one new topic for each Analytics server you install. The
new topic or topics are used to select and segment the extra KPI data that you are
going to analyze using this Analytics server. The first default topic is created when
you install the Analytics component on a new server. For information on how to
create supplementary topics, see Creating a Topic in the Configuring and
Administering Guide.

Installing the UI component
You can use the IBM® Installation Manager User Interface to install the UI
component.

Before you begin

If you want to integrate the UI component with Dashboard Application Services
Hub, you can install the UI component on the same server as Dashboard
Application Services Hub. Alternatively, you can install the UI component and
Dashboard Application Services Hub on separate servers.

If you want to install multiple instances of the UI component with Dashboard
Application Services Hub, you must meet the following requirements:
v You must install each instance of the UI on a separate server.
v You must configure each instance of the UI to use a different Dashboard

Application Services Hub installation.
v You must configure all instances of the UI to use the same Operations Analytics

Predictive Insights Database and the same OMNIbus Object Server.

If you want to install the UI component into an existing Tivoli Integrated Portal
environment, you must install the UI component on the Tivoli Integrated Portal
server.

If you want to install multiple instances of the UI component into Tivoli Integrated
Portal, you must meet the following requirements:
v You must install each instance of the UI component into a separate Tivoli

Integrated Portal installation.
v You must configure all instances of the UI to use the same Operations Analytics

Predictive Insights Database and the same OMNIbus Object Server.

Before you begin installing the UI component, ensure that the following are
complete:
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v Both the Operations Analytics Predictive Insights Database and Analytics
components are installed.

v The Analytics component is configured to forward events to OMNIbus. You can
configure OMNIbus forwarding when you are installing the Analytics
component or after with the configure_omnibus.sh script. For more information,
see Configuring OMNIbus alarm management in the Administering and Configuring
Guide.

v A domain name is configured for the server. During the installation of the UI
component, you need to specify a single sign-on domain.

v Either Tivoli Integrated Portal with WebGUI 7.4 or Dashboard Application
Services Hub with WebGUI 8.1, depending on which application you are using,
is running. The UI installation process restarts Tivoli Integrated Portal or
Dashboard Application Services Hub.

v You copied the installation package to the server on which you are installing the
UI component.

Procedure
1. As the scadmin or root user, open an xterm window on the server on which

you want to install the UI component.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Change to the predictiveInsightsInstaller1.3.5 directory.
4. Enter the following command: ./install.sh

The IBM Installation Manager starts.
5. If no other Operations Analytics Predictive Insights component is installed on

the server or if a component was installed with a different user account to that
which you are using to install the UI component, click the Install option and
complete steps a to m to install the Analytics component:
a. After you click the Install option, the IBM Installation Manager displays the

local installation packages. Select IBM Operations Analytics Predictive
Insights and click Next.

b. On the Licenses page, read the license agreements for Operations Analytics
Predictive Insights. If you agree to the terms of all the license agreements,
click I accept the terms in the license agreements and then click Next.

c. On the Location page, in the Shared Resources Directory field, type the
path for the shared directory. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/shared.
The IBM Installation Manager can share components across products.
Operations Analytics Predictive Insights does not share components with
any other product. It is a requirement of the IBM Installation Manager that
a shared directory is provided when you install it. The shared directory
must be unique for each user who installs the IBM Installation Manager on
the same server.

d. Click Next.
e. On the Location page, Create a new package group is the only available

option for Operations Analytics Predictive Insights
f. In the Installation Directory field, type the path for the installation files. It is

recommended that you use the default directory of /opt/IBM/scanalytics/
install_<user>/installer and then click Next. If you choose to change
Installation Directory from the default, the Installation Directory must be
unique for each user who installs the IBM Installation Manager on the same
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server. The IBM Installation Manager displays all Operations Analytics
Predictive Insights components that can be installed.

g. By default, all components are selected for installation. Clear the check box
beside each component other than UI and click Next. The IBM Installation
Manager displays each set of information that is required under a heading.

h. Click Database connection configuration and enter the required
information.

i. Click Validate to confirm that all settings are correct.
j. Click UI configuration and enter the required information.

In the UI configuration dialog, you must first select the application that you
want to use to display anomalies that are generated by Operations Analytics
Predictive Insights:
v Tivoli Integrated Portal (TIP)

v Dashboard Application Services Hub (DASH)

When you select the Dashboard Application Services Hub (DASH) option
you must also enter UI WebGUI configuration details, and UI local
configuration details. Most items are populated by default. Note the
following:
v Enter DASH profile user/password: Enter the user profile that you

created when you installed Dashboard Application Services Hub.
v Enter single sign on key file password: If you configured Single Sign-On

(SSO) for the IBM WebSphere server on which Dashboard Application
Services Hub is installed, enter the keyfile password that was used when
SSO was configured. A key file password encrypts the private key on the
WebSphere server. If a password was not configured previously, you can
enter a password or leave this field blank.

v Enter single sign-in domain: This entry allows the installer to validate
that both the UI component for Dashboard Application Services Hub and
the Dashboard Application Services Hub itself are on servers that are in
the same domain.

v UI WebGUI Config: In the Enter WebGUI user field, enter the user
details of the user that installed WebGUI. In the Enter OMNIbus user
field, enter the details of the user that installed OMNIbus.

Note: If you specify a WebGUI user other than ncoadmin, ensure that the
user exists in a user repository that is in use in Dashboard Application
Services Hub. Also, ensure that the user has OMNIbus administration
access before you proceed with the UI installation.

k. Click Validate to confirm that all settings are correct.
l. Click Next. The IBM Installation Manager displays the installation summary

information
m. Click Install.

6. If another Operations Analytics Predictive Insights component was installed on
the server with the same user account that you are using to install the UI
component, click the Modify option. The IBM Installation Manager displays the
local installation packages. To complete the installation, follow steps a to e.
a. Select IBM Operations Analytics Predictive Insights and click Next.
b. Select UI and click Next.

Note: The check box beside any component that was previously installed is
automatically checked. Do not clear the check box beside any component

40 IBM Operations Analytics Predictive Insights: Installation Guide



that was previously installed as this action causes the component to be
uninstalled during the modify operation.

c. Click Next.
d. Click Modify.
e. Click Finish when the modify operation is complete.

Installing the Mediation Tool
The Operations Analytics Predictive Insights Mediation Tool is used to configure
the data presentation to Operations Analytics Predictive Insights. The Mediation
tool can be installed on Windows or Linux systems.

Before you begin

Note: The installation script can install components only to the server on which it
is running. Copy the installation package to the server on which you are installing
the component.

It is recommended that you install the Mediation Tool on the same server as the
Analytics component.

Note: If you can't access a graphical display on the server that hosts the Analytics
component, you can install the Mediation Tool on a Linux desktop system, or on a
Windows desktop system. For information on how to install the Mediation Tool on
a Windows system, see “Installing the Mediation tool on Windows” on page 51.
Installing to a Linux desktop system is performed in the same way as described in
the following procedure.

About this task

To install the Mediation Tool, complete the following steps:

Procedure
1. As the scadmin or root user, open an xterm window on the server on which

you want to install the Mediation tool.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Change to the predictiveInsightsInstaller1.3.5 directory.
4. Enter the following command: ./install.sh

The IBM Installation Manager is launched.
5. If there is no other Operations Analytics Predictive Insights component

installed on the server or if a component was installed with a different user
account to that which you are using to install the Mediation tool, click Install.
Complete steps a to k to install the Mediation Tool:
a. After you click the Install option, the IBM Installation Manager displays the

local installation packages. Select IBM Operations Analytics Predictive
Insights and click Next.

b. On the Licenses page, read the license agreements for Operations Analytics
Predictive Insights. If you agree to the terms of all the license agreements,
click I accept the terms in the license agreements and then click Next.

c. On the Location page, in the Shared Resources Directory field, type the
path for the shared directory. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/shared.
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The IBM Installation Manager can share components across products.
Operations Analytics Predictive Insights does not share components with
any other product. It is a requirement of the IBM Installation Manager that
a shared directory is provided when you install it. The shared directory
must be unique for each user who installs the IBM Installation Manager on
the same server.

d. Click Next.
e. On the Location page, Create a new package group is the only available

option for Operations Analytics Predictive Insights.
f. In the Installation Directory field, type the path for the installation files and

click Next. It is recommended that you use the default directory of
/opt/IBM/scanalytics/install_<user>/installer. If you choose to change
Installation Directory from the default, note that the Installation Directory
must be unique for each user who installs the IBM Installation Manager on
the same server.
The IBM Installation Manager displays all Operations Analytics Predictive
Insights components that can be installed.

g. By default, all components are selected for installation. Clear the check box
beside each component other than Mediation tool and click Next. The IBM
Installation Manager displays each distinct set of information required
under a heading.

h. Click Mediation tool configuration and enter the required information.
i. Click Validate to confirm that all settings are correct.
j. Click Next. The IBM Installation Manager displays the installation summary

information.
k. Click Install.

6. If another Operations Analytics Predictive Insights component was installed on
the server with the same user account that you are using to install the
Mediation tool, click the Modify option. Complete steps a to f to install the
Mediation Tool.
a. After you click the Modify option, the IBM Installation Manager displays

the local installation packages.
b. Select IBM Operations Analytics Predictive Insights and click Next.
c. Select Mediation tool and click Next.

Note: The check box beside any component that was previously installed is
automatically checked. Do not clear the check box for any component that
was previously installed. If you clear the check box for a component that is
already installed, it is uninstalled during the modify operation.

d. Click Next.
e. Modify

f. Click Finish when the modify operation is complete.
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Console Installation
You can install Operations Analytics Predictive Insights in console mode if you
cannot access a graphical display.

Installing the Database component
You must complete the following steps to install the Database component using the
IBM® Installation Manager command-line interface.

Before you begin

The Operations Analytics Predictive Insights Database component can be installed
by the database owner or by the root user.

Note: The installation script can install components only to the server on which it
is running. Copy the installation package to the server on which you are installing
the Database component.

Procedure
1. As the database owner, root, or a user that is part of the same group as the

database owner, for example, scadmin, open a terminal session on the server.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Run the command:

./install.sh -c

The IBM Installation Manager console installer is launched.

Note: The console accepts both upper and lower case.
4. Type 1 to Install and press Enter.
5. Type 1 to select IBM Operations Analytics Predictive Insights 1.3.5 and press

Enter.
6. Type 1 to choose version to install and press Enter.
7. Type n to select package and press Enter.
8. Type a to accept license agreement and press enter
9. Type n and press Enter.

10. To change Shared Resources location type m, or else type n to accept the
default location, and press Enter. The suggested default directory is
/opt/IBM/scanalytics/install_<user>/shared. The IBM Installation Manager
can share components across products. Operations Analytics Predictive
Insights does not share components with any other product. It is a
requirement of the IBM Installation Manager that a shared directory is
provided when you install it. The shared directory must be unique for each
user who installs the IBM Installation Manager on the same server.

11. To change Packages location type m, or else type n to accept the default
location, and press Enter. It is recommended that you use the default directory
of /opt/IBM/scanalytics/install_<user>/installer. If you want to change
the default Installation Directory, the directory must be unique for each user
who installs the IBM Installation Manager on the same server. The IBM
Installation Manager displays all Operations Analytics Predictive Insights
components that can be installed.
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12. By default, all components are selected for installation. Deselect all
components other than Database and type n. The IBM Installation Manager
displays each distinct set of required details under a heading.

13. Enter the connection details for the database. The Update to create DB on a
specific location is an optional setting that you can use to specify an
installation location for the database that is not the default DB2 location. The
directory must exist and be owned by the DB2 instance user.

14. If validation fails, type r to re-enter values, or else type n to continue
15. Type i to install.
16. Type f to finish.
17. Type x to exit.

Installing the Analytics component
You must complete the following steps to install the Analytics component using
the IBM® Installation Manager command-line interface.

Before you begin

Make sure that you have copied the installation package to the server on which
you are installing the Analytics component.

Make sure the server has the following prerequisites installed:
v
v . This prerequisite is installed automatically when you install IBM® InfoSphere®

Streams.

About this task

The Operations Analytics Predictive Insights Analytics component can be installed
by the InfoSphere Streams administrator, which was set to be scadmin during the
InfoSphere Streams install, or by the root user.

Note: The installation script can install components only to the server on which it
is running. Copy the installation package to the server on which you are installing
the component.

It is recommended that you use the same user account to install the Mediation tool
and the Analytics component, that is, the InfoSphere Streams administrator.

The Operations Analytics Predictive Insights Database component must be
installed before the Analytics component can be installed. If you install the
Database and Analytics components together, the Installation Manager
automatically completes the Database installation first.

Procedure
1. As the scadmin or root user, open a terminal session on the server on which

you want to install the Analytics component.
2. Navigate to the directory that contains the extracted Operations Analytics

Predictive Insights installation package.
3. Run the command:

./install.sh -c

The IBM Installation Manager console installer is launched.
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Note: The console accepts both upper and lower case.
4. If there is no other Operations Analytics Predictive Insights component

installed on the server or if a component was installed with a different user
account to that which you are using to install the Analytics component, type 1
to Install and press Enter. The IBM Installation Manager displays the local
installation packages. Complete steps a to l to install the Analytics component.
a. The IBM Installation Manager displays the local installation packages. Type

1 to select IBM Operations Analytics Predictive Insights 1.3.5 and press
Enter.

b. Type 1 to choose version to install and press Enter.
c. Type n to select package and press Enter.
d. Type a to accept license agreement and press Enter.
e. Type n and press Enter.
f. To change Shared Resources location type m, or else type n to accept the

default location, and press Enter. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/shared. The IBM Installation
Manager can share components across products. Operations Analytics
Predictive Insights does not share components with any other product. It is a
requirement of the IBM Installation Manager that a shared directory be
provided when you install it. The shared directory must be unique for each
user who installs the IBM Installation Manager on the same server.

g. To change Packages location type m, or else type n to accept the default
location, and press Enter. It is recommended that you use the default
directory of /opt/IBM/scanalytics/install_<user>/installer. If you want
to change the default Installation Directory, note that the Installation
Directory must be unique for each user who installs the IBM Installation
Manager on the same server. The IBM Installation Manager displays all
Operations Analytics Predictive Insights components that can be installed.

h. By default, all components are selected for installation. Deselect all
components other than Analytics and type n. The IBM Installation Manager
displays each distinct set of information required under a heading.
If you want to integrate Operations Analytics Predictive Insights with
OMNIbus, configure event forwarding for OMNIbus.

Note: If you have a multi-tiered OMNIbus environment, for example, a
collection ObjectServer, an aggregation ObjectServer, and a display
ObjectServers, you can configure alarm forwarding to any one of these
ObjectServers during the installation. After you complete the installation,
and before extracting any data, you must run the configure_omnibus
command against each ObjectServer in the environment.

For more information, see Configuring alarm forwarding from the Analytics
server to an OMNIbus ObjectServer in the Configuration and Administration
Guide.

If the OMNIbus ObjectServer requires a Secure Sockets Layer (SSL)
connection, you must specify the directory path to ObjectServer's SSL
certificate.

i. If validation fail type r to re-enter values, or else type n to continue.
j. Type i to install.
k. Type f to finish.
l. Type x to exit.
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5. If another IBM Operations Analytics Predictive Insights component was
installed on the server with the same user account that you are using to install
the Analytics component, type 3 to Modify and press Enter. The IBM
Installation Manager displays the local installation packages. Complete steps a
to f to install the Analytics component:
a. Type 1 to select IBM Operations Analytics Predictive Insights and press

Enter.
b. Type n to select package and press Enter.
c. Type 2 to select the Analytics component and press Enter.

Note: Any component that was previously installed is automatically
checked. Do not deselect any component that was previously installed as
this action causes the component to be uninstalled during the modify
operation.
The IBM Installation Manager displays each distinct set of information
required under a heading.
If you want to integrate Operations Analytics Predictive Insights with
OMNIbus, configure event forwarding for OMNIbus.

Note: If you have a multi-tiered OMNIbus environment, for example, a
collection ObjectServer, an aggregation ObjectServer, and a display
ObjectServers, you can configure alarm forwarding to any one of these
ObjectServers during the installation. After you complete the installation,
and before extracting any data, you must run the configure_omnibus
command against each ObjectServer in the environment.

For more information, see Configuring alarm forwarding from the Analytics
server to an OMNIbus ObjectServer in the Configuration and Administration
Guide.

d. Type n and press Enter to start the installation.
e. Type f and press Enter when the modify operation is complete.
f. Type x to exit.

Installing the UI component
You can use the IBM® Installation Manager command-line interface to install the UI
component.

Before you begin

If you want to integrate the UI component with Dashboard Application Services
Hub, you can install the UI component on the same server as Dashboard
Application Services Hub. Alternatively, you can install the UI component and
Dashboard Application Services Hub on separate servers.

If you want to install multiple instances of the UI component with Dashboard
Application Services Hub, you must meet the following requirements:
v You must install each instance of the UI on a separate server.
v You must configure each instance of the UI to use a different Dashboard

Application Services Hub installation.
v You must configure all instances of the UI to use the same Operations Analytics

Predictive Insights Database and the same OMNIbus Object Server.
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If you want to install the UI component into an existing Tivoli Integrated Portal
environment, you must install the UI component on the Tivoli Integrated Portal
server.

If you want to install multiple instances of the UI component into Tivoli Integrated
Portal, you must meet the following requirements:
v You must install each instance of the UI component into a separate Tivoli

Integrated Portal installation.
v You must configure all instances of the UI to use the same Operations Analytics

Predictive Insights Database and the same OMNIbus Object Server.

Before you begin installing the UI component, ensure that the following are
complete:
v Both the Operations Analytics Predictive Insights Database and Analytics

components are installed.
v The Analytics component is configured to forward events to OMNIbus. You can

configure OMNIbus forwarding when you are installing the Analytics
component or after with the configure_omnibus.sh script. For more information,
see Configuring OMNIbus alarm management in the Administering and Configuring
Guide.

v A domain name is configured for the server. During the installation of the UI
component, you need to specify a single sign-on domain.

v Either Tivoli Integrated Portal with WebGUI 7.4 or Dashboard Application
Services Hub with WebGUI 8.1, depending on which application you are using,
is running. The UI installation process restarts Tivoli Integrated Portal or
Dashboard Application Services Hub.

v You copied the installation package to the server on which you are installing the
UI component.

Procedure
1. Open a terminal session on the server on which you want to install the UI

component.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Run the command:

./install.sh -c

The IBM Installation Manager console installer is launched.

Note: The console accepts both upper and lower case.
4. If there is no other Operations Analytics Predictive Insights component

installed on the server or if a component was installed with a different user
account to that which you are using to install the UI component, type 1 to
Install and press Enter. The IBM Installation Manager displays the local
installation packages. Complete steps a to p to install the UI component.
a. Type 1 to select IBM Operations Analytics Predictive Insights 1.3.5 and press

Enter.
b. Type 1 to choose version to install and press Enter.
c. Type n to select package and press Enter.
d. Type a to accept license agreement and press Enter.
e. Type n and press Enter.
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f. To change Shared Resources location, type m, or else type n to accept the
default location, and press Enter. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/shared. The IBM Installation
Manager can share components across products. Operations Analytics
Predictive Insights does not share components with any other product. It is a
requirement of the IBM Installation Manager that a shared directory be
provided when you install it. The shared directory must be unique for each
user who installs the IBM Installation Manager on the same server.

g. To change Packages location type m, or else type n to accept the default
location, and press Enter. It is recommended that you use the default
directory of /opt/IBM/scanalytics/install_<user>/installer. If you
choose to change default Installation Directory, note that the Installation
Directory must be unique for each user who installs the IBM Installation
Manager on the same server. The IBM Installation Manager displays all
Operations Analytics Predictive Insights components that can be installed.

h. By default, all components are selected for installation. Deselect all
components other than UI and type n. The IBM Installation Manager
displays each distinct set of details required under a heading.

i. Enter the connection details for your database as requested.
j. If validation fails, choose r to re-enter values, or else type n to continue.
k. Select the application you wish to use to display anomalies generated by

Operations Analytics Predictive Insights. Type 1 to use Tivoli Integrated
Portal (TIP) or type 2 to use Dashboard Application Services Hub (DASH).

l. Enter the details for the application you select.
m. Type i to install.
n. Type f to finish.
o. Type x to exit.

5. If another Operations Analytics Predictive Insights component was installed on
the server with the same user account that you are using to install the UI
component, type 3 to Modify and press Enter. The IBM Installation Manager
displays the local installation packages. Complete steps a to f to install the UI
component.
a. Type 1 to select IBM Operations Analytics Predictive Insights and press

Enter.
b. Type n to select package and press Enter.
c. Type 4 to select the UI component and press Enter.
d. Type n and press Enter to start the installation.
e. Type f and press Enter when the modify operation is complete.
f. Type x to exit.

Installing the Mediation Tool
The Operations Analytics Predictive Insights Mediation Tool is used to configure
the data presentation to Operations Analytics Predictive Insights. The Mediation
tool can be installed on Windows or Linux systems.

Before you begin

Note: The installation script can install components only to the server on which it
is running.

Make sure that you have copied the installation package to the server on which
you are installing the component.
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It is recommended that you install the Mediation Tool on the same server on
which you installed the Analytics component.

Note: If you are unable to gain access to a graphical display on the server hosting
the Analytics component, you can install the Mediation Tool on a Linux desktop
system, or on a Windows desktop system. For details on installing the Mediation
Tool on a Windows system, see “Installing the Mediation tool on Windows” on
page 51. Installing to a Linux desktop system is performed in the same way as
described in the following procedure.

About this task

To install the Mediation Tool in console mode, complete the following steps:

Procedure
1. As the InfoSphere Streams administrator or root user, open a terminal session

on the server on which you want to install the Mediation tool.
2. Navigate to the directory that contains the extracted Operations Analytics

Predictive Insights installation package.
3. Run the command:

./install.sh -c

The IBM Installation Manager console installer is launched.

Note: The console accepts both upper and lower case.
4. If there is no other IBM Operations Analytics Predictive Insights component

installed on the server or if a component was installed with a different user
account to that which you are using to install the Mediation tool, type 1 to
Install and press Enter. The IBM Installation Manager displays the local
installation packages. Complete steps a to k to install the Mediation tool.
a. Type 1 to select IBM Operations Analytics Predictive Insights 1.3.5 and press

Enter.
b. Type 1 to choose version to install and press Enter.
c. Type n to select package and press Enter.
d. Type a to accept license agreement and press Enter.
e. Type n and press Enter.
f. To change Shared Resources location type m, or else type n to accept the

default location, and press Enter. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/shared. The IBM Installation
Manager can share components across products. Operations Analytics
Predictive Insights does not share components with any other product. It is a
requirement of the IBM Installation Manager that a shared directory be
provided when you install it. The shared directory must be unique for each
user who installs the IBM Installation Manager on the same server.

g. To change Packages location type m, or else type n to accept the default
location, and press Enter. The recommended default directory is
/opt/IBM/scanalytics/install_<user>/installer. If you want to change
the default Installation Directory, note that the Installation Directory must
be unique for each user who installs the IBM Installation Manager on the
same server. The IBM Installation Manager displays all Operations Analytics
Predictive Insights components that can be installed.
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h. By default, all components are selected for installation. Deselect all
components other than Mediation tool and type n. The IBM Installation
Manager displays each distinct set of information required under a heading.

i. Type i to install.
j. Type f to finish.
k. Type x to exit.

5. If another Operations Analytics Predictive Insights component was already
installed on this server with the same user account that you are using to install
the Mediation tool, type 3 to Modify and press Enter. The IBM Installation
Manager displays the local installation packages. Complete steps a to f to install
the Mediation tool.
a. Type 1 to select IBM Operations Analytics Predictive Insights and press

Enter.
b. Type n to select package and press Enter.
c. Type 3 to select the Mediation tool and press Enter.
d. Type n and press Enter to start the installation.
e. Type f and press Enter when the modify operation is complete.
f. Type x to exit.

Post-installation - System status
After installation, Operations Analytics Predictive Insights is ready to configure
into a working system.

The following elements are in place and ready to use when Operations Analytics
Predictive Insights installation is complete:
v The administration CLI is usable by the Linux user account that installed

Operations Analytics Predictive Insights, that is, the Operations Analytics
Predictive Insights account, which is by default scadmin.

v OMNIbus columns are created in the ObjectServer to store and display anomaly
information if you set up alarm forwarding from the Analytics component to an
OMNIbus ObjectServer during the installation.

Note: If you have an environment with multiple OMNIbus ObjectServers, you
must create columns on each ObjectServer to store and display anomaly
information. For more information, see Configuring alarm forwarding from the
Analytics server to an OMNIbus ObjectServer.

v An OMNIbus mini-distribution is installed transparently as part of Operations
Analytics Predictive Insights.

v The probe configuration files are updated to configure the connection to the
Object Server.

v A default set of probe rules file is installed. The rules file stores all relevant
attributes in the Object Server database.

v The right-click menu is configured in OMNIbus WebGUI during the UI
component installation.

v Access rights are granted to view events in Operations Analytics Predictive
Insights. The way in which rights are granted depends on whether you installed
Operations Analytics Predictive Insights into Tivoli Integrated Portal or
Dashboard Application Services Hub:

Dashboard Application Services Hub
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v Two existing Omnibus groups, Netcool_OMNIbus_User and
Netcool_OMNIbus_Admin, are granted rights to view Operations Analytics
Predictive Insights events.

v The Dashboard Application Services Hub administrative user, ncoadmin, is added
to the Netcool_OMNIbus_Admin group.

Note: The password for the ncoadmin account defaults to the DASH profile user
password, typically smadmin. However, if Tivoli Integrated Portal was previously
installed on the server, the password for the ncoadmin account defaults to the
tipadmin user password.

Tivoli Integrated Portal
v Two new groups, predictiveInsightsUsers and predictiveInsightsAdmin, are

created in Omnibus. By default, both groups have rights to view Operations
Analytics Predictive Insights events.

v Two new user roles, predictiveInsightsAdmin and predictiveInsightsUser, are
created in Tivoli Integrated Portal. By default, both roles have rights to view
Operations Analytics Predictive Insights events. The Tivoli Integrated Portal
administrator, usually tipadmin, is given both roles.

Installing the Mediation tool on Windows
The Operations Analytics Predictive Insights Mediation tool can be installed on
Windows as well as Linux.

Procedure

Instructions on how to install the Mediation tool on Windows.
1. Log on to the Windows environment to which you want to install the

Mediation tool.
2. Extract the Operations Analytics Predictive Insights package from the media.
3. Open the windowsMediationTool folder within the extracted package. This

folder contains the file PredictiveInsights-MediationTooling-1.3.5-win32.zip.
4. Extract the ZIP file to your desired installation location.
5. Open the folder to which you extracted the ZIP file, and in turn open the

contained eclipse folder.
6. Double click on the eclipse.exe icon. When you open the tool, you will be

asked to choose a workspace. Choose a directory unique to the Mediation tool.

What to do next
After you install Operations Analytics Predictive Insights you must complete some
post installation tasks.

About this task

For information on the post installation tasks, see Initial configuration of Operations
Analytics Predictive Insights in the Operations Analytics Predictive Insights: Configuring
and Administering Guide.
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Chapter 4. Uninstalling Operations Analytics Predictive
Insights

How to uninstall the Operations Analytics Predictive Insights system.

Operations Analytics Predictive Insights offers both an interactive and a silent
uninstallation.

Uninstalling Operations Analytics Predictive Insights
How to uninstall Operations Analytics Predictive Insights.

About this task

If you distributed the installation of Operations Analytics Predictive Insights
components, that is, installed components on separate servers, you must uninstall
components in the following order:
1. UI
2. Mediation tool
3. Analytics
4. Database

Note: You must uninstall each component as the user that installed that
component. If you distributed the installation of these components, log on to each
of the servers and run the following steps.

Procedure
1. Log on to the server as the appropriate user.
2. Go to the directory that contains the extracted Operations Analytics Predictive

Insights installation package.
3. Change to the predictiveInsightsInstaller1.3.5 directory.
4. Run ./install.sh
5. Select Uninstall

6. Click Next.
7. Click the check box for Operations Analytics Predictive Insights.
8. Click Next.

The next panel displays all the components that were installed as the current
user.

9. To uninstall each component:
a. Enter the requested passwords.
b. Click Validate.
c. Click Next when all conditions are satisfied.

10. When all component selections are validated, click Uninstall.
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What to do next

If you are using Dashboard Application Services Hub, you must manually delete
the pages that Operations Analytics Predictive Insights installed into Dashboard
Application Services Hub. Complete the following steps to delete the pages:
1. Log in to Dashboard Application Services Hub as an administrative user,

typically ncoadmin.
2. Go to Console Settings ->Pages.
3. Expand Incidents ->Events.
4. Click the check boxes for Detected Anomalies and Service Diagnosis

Dashboard.
5. Click Delete.
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Chapter 5. Installation log files

The log files that are created during the installation of Operations Analytics
Predictive Insights.

The installation log file: /tmp/tasp_install_<user><date>.log

The command-line interface log file: $PI_HOME/log/cli/cli_trace.log.

Where $PI_HOME is the installation location of the analytics component.
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Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM‘s application programming interfaces.
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If you are viewing this information in softcopy form, the photographs and color
illustrations might not be displayed.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at http://www.ibm.com/legal/copytrade.shtml.

Adobe, Acrobat, PostScript and all Adobe-based trademarks are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
other countries, or both.

Cell Broadband Engine and Cell/B.E. are trademarks of Sony Computer
Entertainment, Inc., in the United States, other countries, or both and is used under
license therefrom.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries,
or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other company, product, and service names may be trademarks or service marks
of others.

For trademark attribution, visit the IBM Terms of Use Web site
(http://www.ibm.com/legal/us/).
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